# TABLE OF CONTENTS

## 1  WELCOME

- Legal ........................................ 05  
- Safety and Compliance .................... 07  
- About the MakerBot Replicator Z18 ...... 10  

## 2  GETTING STARTED

- Accessory Checklist ....................... 15  
- Unpacking the MakerBot Replicator Z18 16  
- Setting up the MakerBot Replicator Z18 21  

## 3  STARTUP

- The MakerBot Replicator Z18 Control Panel 26  
- First Steps .................................. 27  

## 4  MAKERBOT DESKTOP

- Downloading and Installing MakerBot Desktop 31  
- Printing from MakerBot Desktop .......... 33  

## 5  THE CONTROL PANEL

- Home Screen ................................ 42  
- Print ......................................... 43  
- Filament ..................................... 47  
- Preheat ...................................... 49  
- Utilities ..................................... 49  
- Settings .................................... 51  
- Info ......................................... 52  

VERSION 1
**TABLE OF CONTENTS**

<table>
<thead>
<tr>
<th>Page</th>
<th>Section</th>
</tr>
</thead>
<tbody>
<tr>
<td>53</td>
<td>TROUBLESHOOTING</td>
</tr>
<tr>
<td>54</td>
<td>Printing Problems</td>
</tr>
<tr>
<td>57</td>
<td>Leveling the Build Plate</td>
</tr>
<tr>
<td>59</td>
<td>Updating Firmware</td>
</tr>
<tr>
<td>59</td>
<td>Emptying the Filament Waste Bin</td>
</tr>
<tr>
<td>60</td>
<td>REFERENCE</td>
</tr>
<tr>
<td>61</td>
<td>Specifications</td>
</tr>
<tr>
<td>62</td>
<td>Glossary</td>
</tr>
<tr>
<td>65</td>
<td>How to use MakerBot Support</td>
</tr>
<tr>
<td>66</td>
<td>Contact</td>
</tr>
</tbody>
</table>
Welcome to the User Manual for the MakerBot® Replicator® Z18 3D Printer. With the MakerBot Replicator Z18 you can print high-resolution, industrial-quality prototypes bigger than ever, but it also requires care and attention, so please be sure to read this manual all the way through.
LEGAL

PRODUCT WARRANTY

The MakerBot® Replicator® Z18 3D Printer is covered by a limited warranty. For terms and conditions, see makerbot.com/legal.

OVERALL PROVISIONS

All information in this user manual (“Manual”) is subject to change at any time without notice and is provided for convenience purposes only. MakerBot Industries, LLC and our respective affiliates and suppliers (“MakerBot”) reserves the right to modify or revise this Manual in its sole discretion and at any time and makes no commitment to provide any such changes, updates, enhancements, or other additions to this Manual in a timely manner or at all. You agree to be bound by any modifications and/or revisions. Contact the MakerBot Support Team for up-to-date information.

In order to protect MakerBot proprietary and confidential information and/or trade secrets, this document may describe some aspects of MakerBot technology in generalized terms.

INTELLECTUAL PROPERTY

The design of this Manual and all text, graphics, information, content, and other material are protected by copyright and other laws. The contents are copyright 2009, 2010, 2011, 2012, 2013, 2014 MakerBot. All rights reserved. Certain trademarks, trade names, service marks, and logos (the “Marks”) used in this Manual are registered and unregistered trademarks, trade names, and service marks of MakerBot and its affiliates. Nothing contained in this Manual grants or should be construed as granting, by implication, estoppel, or otherwise, any license or right to use any Marks without the written permission of MakerBot. Any unauthorized use of any information, materials, or Marks may violate copyright laws, trademark laws, laws of privacy and publicity, and/or other laws and regulations.
LEGAL

DISCLAIMERS

MakerBot does not warrant the accuracy or completeness of the information, products, or services provided by or through this Manual and assumes no responsibility for any typographical, technical, or other inaccuracies in this Manual, which is provided “as is” and without any express or implied warranties of any kind, including warranties of merchantability, fitness for a particular purpose, or non-infringement of intellectual property. In connection with your use of this Manual, MakerBot shall not be liable to you for any damages whatsoever, be they direct, economic, commercial, special, consequential, incidental, exemplary, or indirect damages, even if MakerBot has been advised of the possibility of such damages, including without limitation, loss of business revenue or earnings, lost data, or lost profits. MakerBot assumes no responsibility, nor will be liable, for any damages to, or any viruses or malware that may infect, your computer, telecommunication equipment, or other property caused by or arising from your downloading of any information or materials related to this Manual. The foregoing exclusions do not apply to the extent prohibited by law; please refer to your local laws for any such prohibitions. MakerBot makes no warranties to those defined as “consumers” in the Magnuson-Moss Warranty-Federal Trade Commission Improvement Act.
SAFETY AND COMPLIANCE

Radio and Television Interference
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the Federal Communications Commission (FCC) rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and the receiver.
• Connect the equipment to an outlet on a circuit different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician for help.

You may also find helpful the following booklet, prepared by the FCC: “How to Identify and Resolve Radio-TV Interference Problems.” This booklet is available from the U.S. Government Printing office, Washington, D.C. 20402.

Changes and modifications not expressly approved by the manufacturer or registrant of this equipment can void your authority to operate this equipment under FCC rules.

Manufacturer
MakerBot Industries, LLC
One MetroTech Center, 21st Floor
Brooklyn, NY 11201
347.334.6800
SAFETY AND COMPLIANCE

Safety alert symbols precede each safety message in this manual. These symbols indicate potential safety hazards that could harm you or others or cause product or property damage.

**Warning:** The MakerBot Replicator Z18 generates high temperatures. Always allow the MakerBot Replicator Z18 to cool down before you reach inside.

**Warning:** The MakerBot Replicator Z18 includes moving parts that can cause injury. Never reach inside the MakerBot Replicator Z18 while it is in operation.

**Warning:** There is a risk of shock. The MakerBot Replicator Z18 is not user serviceable.

**Caution:** Avoid leaving the MakerBot Replicator Z18 unattended during operation. If you must leave the MakerBot Replicator Z18 unattended during a print, exercise caution and follow these guidelines:

- Verify that the MakerBot Replicator Z18 has started the print and is operating normally.
- Ensure that filament is wound tightly on the spool, free of tangles and feeding properly.
- Monitor your print periodically.
- If possible, monitor your print via the on-board camera.

**Caution:** Two people are required to lift the MakerBot Replicator Z18. Do not lift alone. To prevent injury, lift with your legs, not your back.

**Caution:** Do not print using materials that have not been approved by MakerBot for use with the MakerBot Replicator Z18. Refer to the Specifications section on page 61 for more information.
SAFETY AND COMPLIANCE

⚠️ **Caution:** The socket outlet must be located near the machine and must be easily accessible.

⚠️ **Caution:** In case of emergency disconnect the MakerBot Replicator Z18 from the socket outlet.

⚠️ **Caution:** The MakerBot Replicator Z18 melts plastic during printing. Plastic odors are emitted during this operation. Make sure to set up the MakerBot Replicator Z18 in a well-ventilated area.

⚠️ **Caution:** Never remove the Smart Extruder from your MakerBot Replicator Z18 or turn off the MakerBot Replicator Z18 during or immediately after printing. Always allow the Smart Extruder to cool completely before removing it from the MakerBot Replicator Z18 or turning off your 3D printer.

⚠️ **Caution:** Do not look directly at any operating LED component.
ABOUT THE MAKERBOT REPLICATOR Z18

HOW IT WORKS

The MakerBot Replicator Z18 makes solid, three-dimensional objects out of melted MakerBot PLA Filament. First, use MakerBot Desktop to translate 3D design files into instructions for the MakerBot Replicator Z18. Then transfer those instructions to the MakerBot Replicator Z18 via USB drive, USB cable, or your local network.

The MakerBot Replicator Z18 will melt MakerBot PLA Filament and squeeze it out onto the build plate in thin lines to build your object layer by layer. With the huge build volume of the MakerBot Replicator Z18, this part of the process can take a long time. During printing, the heated build chamber will allow the extruded PLA to cool slowly, minimizing warping and curling. The method of 3D printing used by the MakerBot Replicator Z18 is called fused deposition modeling.
ABOUT THE MAKERBOT REPLICATOR Z18

MAKERBOT REPLICATOR DIAGRAMS

1. Power switch
2. Power input port
3. USB port
4. Ethernet port
MAKERBOT REPLICA TOR DIAGRAMS

1. Gantry
2. Extruder carriage
3. Filament guide tube
4. Bellows
GETTING STARTED

When you set up your MakerBot® Replicator® Z18 3D printer, remember that it was built and packaged very carefully at the MakerBot factory. We hope you’ll take your time and be just as careful unpacking it and getting it set up.
ACCESSORY CHECKLIST

Inside your MakerBot Replicator Z18 you’ll find everything you need to get started, including a spool of MakerBot PLA filament and a sheet of build plate tape. To order more build plate tape or filament, go to store.makerbot.com
UNPACKING THE MAKERBOT REPLICATOR Z18

1  REMOVE THE BOX

Cut the straps holding the MakerBot Replicator Z18 box in place and lift off the cardboard lid and sleeve.

2  REMOVE PACKAGING MATERIALS

Remove the tape and foam holding the door and filament drawer of the MakerBot Replicator Z18 open.

Peel the film off the outside of the MakerBot Replicator Z18.
UNPACKING THE MAKERBOT REPLICATOR Z18

3 REMOVE ACCESSORIES

Take the accessory and filament boxes out of the MakerBot Replicator Z18 and set them aside.

4 TAKE THE MAKERBOT REPLICATOR Z18 OFF OF THE PALLET

Lift the MakerBot Replicator Z18 off of the pallet and place it on a stable surface.

You will need to remove the lid of the MakerBot Replicator Z18 in order to load filament, so make sure the surface is low enough to allow you to access the top of your 3D printer.

⚠️ **Caution:** Two people are required to lift the MakerBot Replicator Z18. Do not lift alone. To prevent injury, lift with your legs, not your back.
UNPACKING THE MAKERBOT REPLICATOR Z18

5 ADJUST LEVELING FEET

If the MakerBot Replicator Z18 shows any tendency to wobble, stabilize it using the adjustable leveling feet.

To adjust one of the feet, tilt the MakerBot Replicator Z18 up at one corner and rotate the foot to raise or lower that corner of your 3D printer.
UNPACKING THE MAKERBOT REPLICATOR Z18

6 REMOVE LID

Use a tool to unlock the lid of the MakerBot Replicator Z18. Pull the lid off and set it aside.
Remove the orange plastic clips from the top compartment of the MakerBot Replicator Z18. There are two clips, one on the belt at each side.
SETTING UP THE MAKERBOT REPLICATOR Z18

1  INSTALL SMART EXTRUDER

Locate and unwrap the Smart Extruder and press it against the back of the extruder carriage, with the connector pins facing the front of the MakerBot Replicator Z18. Magnets will lock the Smart Extruder into place.

**Note:** If you need to install the Smart Extruder again at any time, go to the control panel and select **Utilities > System Tools > Attach Smart Extruder.**

⚠️ **Caution:** Never remove the Smart Extruder from your MakerBot Replicator Z18 during or immediately after printing. Always allow the Smart Extruder to cool completely before removing it from the MakerBot Replicator Z18.

2  LOAD FILAMENT SPOOL

2a. Locate the Large MakerBot PLA Filament spool and remove it from its plastic bag.

2b. Push the right side of the filament drawer to open it.

2c. Place the spool in the drawer with the MakerBot logo facing up.
3a. Detach the free end of the filament from the spool and insert it into the hole at the back left corner of the filament drawer.

3b. Continue to feed the filament by hand into the slot at the side of the filament drawer. The filament will move up through the MakerBot Replicator Z18 to the top compartment. Stop feeding the filament when you see it emerge from the end of the filament guide tube.
4a. The build plate on the MakerBot Replicator Z18 has two parts: a removable plastic top plate, and a flat, sturdy aluminum base. Turn the latches on the front of the build platform and slide the top plate forward to release it. Then lift the top plate out of the MakerBot Replicator Z18.

4b. Peel the backing off of the sheet of build plate tape and lay the tape flat on the top plate, with the sticky side facing down.

4c. Smooth down the build plate tape so that it is stuck securely to all parts of the top plate.

4d. Fit the top plate onto the projections on the aluminum base and slide it back to snap it into place. Turn the build plate latches to secure the plate.
GETTING STARTED

SETTING UP THE MAKERBOT REPLICATOR Z18

5 PLUG IN AND POWER ON

5a. Make sure the power switch is in the Off position.

5b. Locate the power cord and plug it into the power input port at the back of the MakerBot Replicator Z18.

5c. Plug the power cord into an electrical outlet.

**Caution:** The socket outlet must be located near the equipment and must be easily accessible.

5d. Switch the power on and wait for the MakerBot Replicator Z18 to boot up. This will take several minutes.
The first time you turn on your MakerBot® Replicator® Z18 3D Printer, it will run a setup assistant that will introduce you to the control panel and walk you through everything you need to do to start your first print. Press the dial to begin the setup assistant.
The MakerBot Replicator Z18 is operated by means of a control panel at the lower right of the 3D printer. The control panel includes a color LCD screen, a rotary/push dial, and two buttons.

- Turn the dial to scroll through the available options on a screen.
- Press the dial to make a selection.
- Press the back button to return to the previous section or cancel an action.
- Press the menu button to open a menu with additional options. If a menu is available, a menu icon will appear at the lower right corner of the screen.
FIRST STEPS

LOAD FILAMENT

Your MakerBot Replicator Z18 uses 1.75 mm diameter PLA filament to create 3D printed objects. Once your spool of MakerBot PLA Filament is loaded into the filament drawer and routed up to the top of the MakerBot Replicator Z18, all you have to do is load the free end of the spooled filament into the heated MakerBot Replicator Smart Extruder.

1. When instructed to by the LCD screen, press the control panel dial to start heating the Smart Extruder.

2. Route the filament and filament guide tube under the extruder guard from behind the Smart Extruder.

3. When the Smart Extruder is fully heated, push the free end of the filament into the loading tube. Keep pushing on the filament until you feel the Smart Extruder pulling it in.

4. Wait until you begin to see plastic emerging from the extruder nozzle. Then press the control panel dial to stop extrusion.

5. Push the end of the filament guide tube into the loading tube.

6. Wait a moment for the extruded plastic to cool, then pull it away from the Smart Extruder. Do not touch the nozzle; it may still be hot.

Note: To start the load filament process at any time, use the control panel and navigate to Filament > Load Filament.
FIRST STEPS

PRINT A TEST OBJECT

Once you've loaded filament into your Smart Extruder, you're ready to print something. The LCD panel will display the test prints we've loaded onto your MakerBot Replicator Z18 for you.

Note: To view the files stored on your MakerBot Replicator Z18 at any time, go to Print > Internal Storage.

1. Use the dial to highlight one of the available prints.

2. Push the dial to select your chosen print. You will be taken to the file info view.

3. Select **Print**. The MakerBot Replicator Z18 will print the file you selected.

   **Caution:** Never turn off the MakerBot Replicator Z18 immediately after completing a print. Always allow the Smart Extruder to cool before powering down.

REMOVE YOUR PRINT

When your print is finished, you will need to remove it from the build surface.

1. Allow the build chamber to cool.

2. Turn the build plate latches and slide the top plate forward to release it. Then lift the top plate out of the MakerBot Replicator Z18.

3. Gently pull your print off the top plate.

4. Fit the top plate onto the projections on the aluminum base and slide it back to snap it into place. Turn the build plate latches to secure the plate.
FIRST STEPS

CONNECT TO YOUR COMPUTER

There are four ways to move files from your computer to your MakerBot Replicator Z18: Wi-Fi, Ethernet, USB cable and USB drive. Before you proceed, set up your computer to connect using one of these methods.

To connect via Ethernet:
1. Locate an Ethernet cable (not included).

2. Connect one end of the cable to the Ethernet port at the back of your MakerBot Replicator Z18. Connect the other end to a wall jack or router used by your local area network. MakerBot Desktop will automatically detect your MakerBot Replicator Z18 during software setup.

To connect via USB cable:
1. Locate the included USB cable.

2. Insert the USB-B end of the cable into the port on the back of your MakerBot Replicator Z18 and insert the USB-A end of the cable into a USB port on your computer. MakerBot Desktop will automatically detect your MakerBot Replicator Z18 during software setup.

To connect via Wi-Fi:
1. Locate the included USB cable.

2. Insert the USB-B end of the cable into the port on the back of your MakerBot Replicator Z18 and insert the USB-A end of the cable into a USB port on your computer. MakerBot Desktop will automatically detect your MakerBot Replicator Z18 during software setup and use the USB connection to connect it to your Wi-Fi network.

To transfer files via USB drive:
No additional setup will be required. See Chapter 4 for instructions on exporting print files.
MakerBot Desktop is a free app for preparing 3D prints and managing your 3D content. Whether you print directly to the MakerBot Replicator® Z18 3D Printer via USB cable, Wi-Fi or Ethernet, or you export your print files to a USB drive, MakerBot Desktop is where all your prints will begin.
DOWNLOADING AND INSTALLING MAKERBOT DESKTOP

1. Open a browser session and go to makerbot.com/desktop. Click the Download button.

2. Select your operating system from the dropdown menu on the download pack and click Download. A system-specific installer will download to your computer.

3. Double-click the MakerBot Desktop installer to run the installation wizard. Follow the installation instructions.

4. When you open MakerBot Desktop for the first time, you will be asked to log in.

   • If you have ever logged into MakerBot Thingiverse™ or the MakerBot Store, you already have an account. If not, you can create one now.
   • This account can be used to log into any MakerBot software or website.
   • You can use MakerBot Desktop without logging in, but logging in will allow you to access your MakerBot Cloud Library and additional features in the Explore, Prepare, and Store sections.
5. Select how you will connect your MakerBot Replicator Z18 to your computer. If you will print only via USB drive, click **Skip**. You will be asked to choose a MakerBot 3D Printer. Choose **Replicator Z18**.

You can connect to your MakerBot Replicator via USB cable, Ethernet or Wi-Fi at any time.

**WI-FI**
1. Connect the USB cable to your MakerBot Replicator Z18 and to your computer. MakerBot Desktop will automatically connect to your MakerBot Replicator Z18.

2. Go to the **Devices** menu and select **Device Preferences**.

3. Click **Wi-Fi Settings**.

4. Select your network from the dropdown menu and enter your password. Your MakerBot Replicator Z18 will automatically be connected to your Wi-Fi network.

5. Go to the Devices menu and select **Connect to a New Device**.


**ETHERNET**
1. Connect an Ethernet cable to your MakerBot Replicator Z18 and to your computer.

2. Go to the **Devices** menu and select **Connect to a New Device**.

3. Select your MakerBot Replicator Z18 from the list of available devices.

**USB**
Connect the USB cable to your MakerBot Replicator Z18 and to your computer. MakerBot Desktop will automatically connect to your MakerBot Replicator Z18.
PRINTING FROM MAKERBOT DESKTOP

HOW IT WORKS
MakerBot Desktop consists of four sections: Explore, Library, Prepare and Store.

**Explore** gives you access to Thingiverse and the hundreds of thousands of free 3D printable objects designed by the Thingiverse community. Use Explore to search Thingiverse for inspiration or new things to print, then save them to your collections or prepare them for printing.

**Library** gives you access to your MakerBot Cloud Library and helps you organize your 3D model files. Use it to store things you’ve collected on Thingiverse or bought from the MakerBot Digital Store as well as your own models.

**Prepare** is where you will turn 3D models into print files. Bring 3D models into the Prepare view to manipulate them on a virtual build plate. Then specify print options and send print files to your MakerBot Replicator Z18.

**Store** lets you buy print files for premium 3D models. When you buy a model in the MakerBot Digital Store, a print file for your MakerBot Replicator Z18 will be added to your MakerBot Cloud Library.

**Learn** provides video tutorials on common processes such as exporting files, preparing to print, and exploring Thingiverse. New tutorials will be added in future versions of MakerBot Desktop.

Use Store and Explore to find things to print, Library to keep them organized, and Prepare to send them to your MakerBot Replicator Z18 for printing.
PRINTING FROM MAKERBOT DESKTOP

FINDING A 3D MODEL

Every 3D print starts with a 3D model. If you design a 3D model yourself, export it from your 3D modeling application in STL or OBJ format. If you don’t have a 3D model, download one from Thingiverse, either through the website at Thingiverse.com or through the Explore view in MakerBot Desktop.

• To open a model from Thingiverse, go into the Explore view in MakerBot Desktop, locate the Thing you want to print, and click Prepare to open it in the Prepare view.
• To open a model saved in your Library, go to the Library view and select a folder to browse. Mouse over a list item to show a menu icon. Click the icon and select Prepare to open the model in the Prepare view.
• To open a file saved to your local computer, go to the Prepare view, click Add File, and navigate to the location of the saved file. Select the file and click Open to import it into MakerBot Desktop.

DOWNLOADING AND PRINTING A MODEL FROM THINGIVERSE

1. Click Explore at the top of the MakerBot Desktop screen.

2. See featured Things, browse categories and collections, or use the search bar to look for something specific. Once you have found something you want to print, click the title or thumbnail to go to the Thing page.

3. On the Thing page, you will see additional information about the Thing, including any instructions the designer has included and pictures of copies of the Thing made by other members of the Thingiverse community. To get the file or files you will need to print the Thing, click the Prepare button at the right of the page.

4. You will be shown a list of available files. Next to each listed file is another Prepare button. Click Prepare next to any STL or OBJ file. MakerBot Desktop will download your file and open it in the Prepare view. To add an additional part from the same Thing, return to the Explore view and click Prepare next to the additional part.
PREPARING TO PRINT

You should now see your model or models at the center of a gray rectangle. This is MakerBot Desktop's representation of your 3D printer's build plate. Let’s take a look at the other features visible in the Prepare view.

1. +/-
   - Click the **Plus** and **Minus** buttons to zoom in and out.
   - You can also zoom using a track pad or the scroll wheel on your mouse.

2. **Home**
   - Click the **Home** button to reset MakerBot Desktop to the default view of the build plate.

3. **View**
   - Click the **View** button or press the V key to go into view mode.
   - In View mode, click and drag with your mouse to rotate the build plate.
   - In View mode, hold the Shift key and click and drag with your mouse to pan.
   - Click the View button again to open the Change View submenu and access preset views.
4. **Move**
   - Click the **Move** button or press the M key to go into Move mode.
   - In Move mode, click and drag with your mouse to move your model around on the build plate.
   - In Move mode, hold down the Shift key and click and drag with your mouse to move your model up and down along the z-axis.
   - Click the Move button again to open the Change Position submenu and center your object or move it by a specific distance along the x-, y-, or z-axis.

5. **Turn**
   - Click the **Turn** button or press the T key to go into Turn mode.
   - In Turn mode, click and drag with your mouse to rotate your model around the z-axis.
   - Click the Turn button again to open the Change Rotation submenu and lay your object flat or rotate it by a specific number of degrees around the x-, y-, or z-axis.

6. **Scale**
   - Click the **Scale** button or press the S key to go into Scale mode.
   - In Scale mode, click and drag with your mouse to shrink or enlarge your model.
   - Click the Scale button again to open the Change Dimensions submenu and scale your object by a specific amount on the x-, y-, or z-axis.

7. **File Name**
   - The file name bar displays the name of the file or layout currently open. Thing files can include multiple layouts, or arrangements of models on the plate.

8. **Settings**
   - Click **Settings** to open the settings dialog.
   - Use the dialog to change print settings for the current object or layout.
PRINTING FROM MAKERBOT DESKTOP

9. Add File
   • Click **Add File** to open an Open File dialog.
   • Navigate to the location of any STL, OBJ, or Thing file and select the file to add a model to the build plate.
   • You can add as many models to the plate as will fit. Use the keyboard shortcut Ctrl/Command + L to automatically arrange multiple models on the plate.
   • Duplicate models already on the plate using the **Copy** and **Paste** options in the Edit menu or the keyboard shortcuts Ctrl/Command+C and Ctrl/Command+V.

10. Save to Library
    • Click **Save to Library** to open a Save dialog.
    • If you are logged into your MakerBot account, you can choose to save an STL or Thing file to your Library or to your local computer. See makerbot.com/support for more information on your MakerBot Cloud Library.
    • If you are not logged into your MakerBot account or if you are working offline, you will be able to save your file only to your local computer.
    • If you are working in an existing Thing file, you can rearrange the models on the plate and save this new layout to the Thing file without overwriting earlier layouts.

11. Print/Export Print File
    • Click **Print** to send a print file to your MakerBot Replicator Z18.
    • If MakerBot Desktop is not connected to your MakerBot Replicator Z18, you can export a file by clicking **Export Print File**.

12. Status
    • The status bar displays the connection status of any connected MakerBot 3D Printer.
    • It also displays print progress.
    • Click to open a print monitor panel.
    • The print monitor panel displays more detailed information about any connected MakerBot 3D Printer and a camera view of the build area of any fifth generation MakerBot 3D Printer connected via a network.
PRINTING FROM MAKERBOT DESKTOP

PRINT SETTINGS

If you want to change any settings before printing, click **Settings**. This is where you can specify options that will affect the quality of your printed object, like print resolution and object strength.

To print with standard or previously specified settings, skip this step and go straight to printing.

1. **Resolution**

Choose **Low**, **Standard**, or **High** resolution to specify the surface quality of your 3D print.

- Objects sliced with the Standard resolution profile will be printed using the default settings. Standard resolution prints will print quickly and have good surface quality.
- Objects sliced using the Low resolution profile will be printed with thicker layers and will print faster.
- Objects sliced with the High resolution profile will have finer layers and will print more slowly.

2. **Raft**

Select this checkbox to have your object built on a raft. The raft acts as a base for your object and any support structures, and ensures that everything adheres well to the build plate. The raft will be easily removable once you remove your finished object from the build plate.

3. **Supports**

Select this checkbox to have your object printed with support structures. MakerBot Desktop will automatically generate supports for any overhanging sections of your object. Supports will be easily removable once you remove your finished object from the build plate. If your model does not contain overhangs, do not select this checkbox.
PRINTING FROM MAKERBOT DESKTOP

PRINT SETTINGS

4. Advanced
Click Advanced for additional options, including print speed and object strength. For information on what the advanced settings are and how to use them, go to makerbot.com/support.

5. Cancel
Click Cancel to return to the Prepare view without saving changes. Any print settings you have selected will be discarded.

6. Save Settings
When you are finished, click Save Settings. The saved settings will be used to slice your model next time you print or export a print file.

PRINTING TO THE MAKERBOT REPLICATOR Z18

When you are ready to print, click Print to slice the model using the current settings and send a .makerbot print file to your MakerBot Replicator Z18.

- If MakerBot Desktop is connected to your MakerBot Replicator Z18, the print file will be sent directly to your 3D printer. Click the control panel dial to confirm and start your print.
- If you are not currently connected to a MakerBot 3D printer, the Print button will be disabled. Click Export to save a file to transfer to your MakerBot 3D printer via a USB drive or to print at a later time.
- Click Print Preview in the Print or Export dialog after your object is sliced to open a preview of the sliced model.
PRINTING FROM MAKERBOT DESKTOP

USING THE CAMERA

A feed of images from the onboard camera is always available when you’re connected to your MakerBot Replicator Z18 via Wi-Fi or Ethernet. To view the feed, click the menu icon at the right side of the status bar to open the monitor panel. As long as you are connected to your MakerBot Replicator Z18 via a network, the camera image will refresh every few seconds.

When you connect your new MakerBot Replicator Z18 to MakerBot Desktop for the first time, the camera image may be blurry. You will need to focus it manually to get the best image possible.

To focus the camera:
1. Connect the MakerBot Replicator Z18 to MakerBot Desktop via Wi-Fi or Ethernet and click the status bar to open the monitor panel.

2. Locate the camera. It is mounted inside the front right corner of the MakerBot Replicator Z18.

3. Grasp the plastic ring around the lens and twist it slightly. Avoid touching the camera lens itself.

4. Check the camera feed and wait for the image to refresh. If the image is clearer than it was before, continue twisting the lens in the same direction. If the image is less clear, start twisting the lens in the opposite direction.

5. Twist in small increments, and check the camera feed frequently. When the image is clear and twisting in either direction makes it more blurry, stop making adjustments. You have successfully focused the onboard camera.
The control panel on the MakerBot® Replicator® Z18 3D Printer allows you to interact with your 3D printer. You can use it to initiate prints, edit settings, and access information. This chapter describes the different things you can do with the control panel.
HOME SCREEN

Use the control panel to:

- Print objects from a USB flash drive or the internal storage of your MakerBot Replicator Z18.
- Start prints initiated via MakerBot Desktop.
- Change printer settings.
- View print history and statistics.

1. Print: Initiate a print stored on a USB drive or internal storage, or synced from your MakerBot account.

2. Filament: Load filament into or unload filament from the MakerBot Replicator Smart Extruder.


6. Info: View your 3D printer's history and statistics.
Select the Print icon to initiate a print stored on a USB drive or internal storage or synced from your MakerBot Cloud Library.

1 SELECT A FILE

Turn the dial to scroll through the list of available locations. Push the dial to select the location of the file you want to print.

Select **USB Storage** to print a file stored on a USB drive inserted into the USB port.

Select **Internal Storage** to print a file stored on the MakerBot Replicator Z18. The internal storage has a capacity of about 2 GB.

Select **My Library** to print a sliced file from your MakerBot Cloud Library. In the Library menu:

- Choose **All Things** to access every item synced to your MakerBot Replicator Z18 from your Library.
- Choose **My Designs** for private files synced from your MakerBot Cloud Library.
- Choose **Thingiverse** for items from your MakerBot Thingiverse™ collections.
- Choose **Purchased** for files purchased from the MakerBot Digital Store.

Press the dial to select a location. Turn the dial to scroll through the list of available files and press it again to select one.
2 START PRINT

- If you select a file from the USB drive or internal storage, the control panel will display the file screen.
- If you select something from your MakerBot Cloud Library, you will see a list of all the layouts associated with the file. Scroll through the available layouts and select one in order to go to the file screen.

From the file screen, choose what to do with the part or layout:
- Select **Print** to start printing the file.
- Select **Info** for more information on the part or layout. Turn the dial to toggle between three information screens.
- Select **Copy** to copy a file to internal storage or to an attached USB drive.
PRINTING
During a print, you will be able to view print progress information as well as other details about your print.

1. Percentage of the print completed.

2. Time elapsed and estimated time remaining in the print. While the Smart Extruder is heating, this area will display the current and target temperatures.

3. Location in active print screens. Turn the dial to scroll between the following screens:
   - Print progress
   - Rendering of your model or layout
   - File information
   - Print options information

4. Print Menu. Press the control panel’s Menu button to open the Print menu. The Print menu contains the following options:
   - **Pause.** Select this option to temporarily pause your print. You can also pause by pressing the control panel dial.
   - **Change Filament.** Select this option to pause your print and go directly to the Filament menu.
   - **Take a Picture.** Select this option to take a picture of the build area with built-in camera. The picture will be saved to internal storage.
   - **Set Pause Height.** Select this option to set your print to pause at a predetermined height.
   - **Cancel.** Select this option to cancel your print. You can also cancel a print by pressing the back button.
If you are printing a file from Thingiverse, you will be prompted to share a photo. Photos shared to Thingiverse will appear on the Thing page in the I Made one! section. Sharing a photo is a nice thing to do – other Thingiverse users will love to see how your prints of their designs come out.

To share a photo, select **Share to Thingiverse**. The MakerBot Replicator Z18 will take a photograph of your build area. Push the dial again to post the photo to the Thing page.

If you do not wish to share a photo of your print to Thingiverse, select **Back to Menu**. The MakerBot Replicator Z18 will send a photograph to the Print History section of your MakerBot Cloud Library.
Select the **Filament** icon to load or unload filament.

**To load filament:**
1. Use the dial to select Load filament.
2. Unlock and remove the lid of the MakerBot Replicator Z18.
3. Wait for the Smart Extruder to heat.
4. Cut the end of your filament to create a clean edge.
5. Grasp the top of the extruder assembly and push the filament into the Smart Extruder's loading tube until you can feel the motor pulling the filament in.

When filament is loaded, insert the end of the filament guide tube unto the Smart Extruder's loading tube and replace and lock the lid of the MakerBot Replicator Z18.

**To unload filament:**
1. Use the dial to select unload filament.
2. Unlock and remove the lid of the MakerBot Replicator Z18.
3. Wait for the Smart Extruder to heat.
4. Allow the Smart Extruder to unload filament. This process includes multiple steps. Wait until the control panel tells you to remove the filament from the Smart Extruder.
5. Pinch the tabs at the side of the Smart Extruder, grasp the filament and pull it free.

When filament is unloaded, begin the steps to load filament or replace and lock the lid of the MakerBot Replicator Z18.
To change filament spools:
1. Unload filament.

2. Open the filament drawer and rotate the spool counterclockwise to wind the filament by hand around the spool.

⚠️ **Caution:** Be careful to keep the spool tightly wound as you pull the filament free of the guide tube. If you do not, the filament could unravel or tangle on the spool.

3. Remove the spool from the filament drawer.

4. Place the new spool in the drawer with the MakerBot logo facing up.

5. Detach the free end of the filament from the spool and insert it into the hole at the back left corner of the filament drawer.

6. Continue to feed the filament into the slot at the side of the filament drawer. Stop when you see filament emerge from the end of the tube in the top compartment of the MakerBot Replicator Z18 by hand.
PREHEAT

Select the Preheat icon to preheat the Smart Extruder. When you select Preheat, the Smart Extruder will immediately start heating. The current and target temperatures will be visible on the main screen.

UTILITIES

Use the Utilities menu to access plate leveling, diagnostics and other tools.

Level Build Plate
Select to begin the assisted leveling process. For best results when leveling, make sure filament is unloaded and the extruder nozzle is clean, and wipe any plastic debris off of the build plate.

Camera
Select to access options related to your 3D printer's built-in camera. In the camera menu, you can:
- Take a photo of the build area using the built-in camera.
- Browse photos taken by the built-in camera.
- Copy photos to the USB drive.
- Erase all photos taken with the built-in camera to date.

Park
Select to lower the build platform in order to access the build plate, filament waste bin and camera.
UTILITIES

SYSTEM TOOLS

Additional options are available under **System Tools**.

**Home Position**
Select to move the build platform and extruder assembly to their home positions. The build platform will move all the way down and the extruder carriage will move to the front left corner of the MakerBot Replicator Z18.

**Attach Smart Extruder**
Select for assistance in attaching the MakerBot Replicator Smart Extruder.

**Diagnostics**
Select to run a diagnostic sequence or to copy recent diagnostics logs to the USB drive. If the diagnostic sequence flags any issues, please contact MakerBot Support by emailing support@makerbot.com

**System Logs**
Select to clear the log files for your MakerBot Replicator Z18 or to copy them to a USB drive.

**Restore Factory Settings**
Select to return all settings on your MakerBot Replicator Z18 to the factory defaults.

**Power Off**
Select to turn your MakerBot Replicator Z18 off. After you turn the MakerBot Replicator Z18 off by selecting this option, you will be able to turn it back on by pushing the control panel dial.
Use the **Settings** menu to edit network and sharing settings and to personalize your MakerBot Replicator Z18.

**Network Settings**
- **Network Info.** Select for information about your network connection.

**MakerBot Account**
- **Unlink Account.** Select to unlink your MakerBot account from the MakerBot Replicator Z18. You will not be able to share to Thingiverse or print items from your MakerBot Cloud Library when logged out.

**Other Settings**
- **Name.** Select to change the name used to represent your MakerBot Replicator Z18.
INFO

Use the Info menu to view your 3D printer’s history and statistics.

**Firmware**
View the version number of the firmware currently installed on your MakerBot Replicator Z18.

**Statistics**
Select to view printing statistics, including total print time and the amount of space available in internal storage.

**History**
Select to view recently printed items. Select an individual item from the list to view the date, print time, and quantity of filament used. Press the menu button to change the order of the listed items or to export the list to a CSV file that can be saved to a USB drive.
As you get to know your MakerBot® Replicator® Z18 3D Printer, you may run into issues with different parts of the printing process. Here is a handy guide to some simple-to-fix problems. For help with issues not covered in this chapter, go to makerbot.com/support or contact the MakerBot Support team by emailing support@makerbot.com
## PRINTING PROBLEMS

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Can’t load filament into the MakerBot Replicator Smart Extruder.</td>
<td>Try unloading and loading again. Hold the Smart Extruder in place and try pushing the filament through. Push hard; as long as you are holding the Smart Extruder in place, pushing on the filament will not damage it.</td>
</tr>
<tr>
<td>Can’t remove filament from the Smart Extruder.</td>
<td>Try running the filament load script and allowing plastic to extrude for a few seconds. Then try unloading again.</td>
</tr>
<tr>
<td>Filament won’t extrude from the Smart Extruder.</td>
<td>Try unloading and reloading the filament. You may be able to avoid jams in the future by allowing the Smart Extruder to cool before turning off your MakerBot Replicator Z18.</td>
</tr>
<tr>
<td>Printed object is stuck to the build plate.</td>
<td>Remove the plastic top plate from your MakerBot Replicator Z18 if you have not already done so. If you are still not able to remove your print from the build plate, try flexing the plastic plate slightly.</td>
</tr>
</tbody>
</table>
## PRINTING PROBLEMS

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>Object peels off the build plate during printing.</td>
<td>Make sure that the build plate tape is clean and securely applied to the build plate. If prints continue to peel off the plate, your plate may no longer be level. Follow the instructions on page 57 to level the build plate.</td>
</tr>
<tr>
<td>Touchscreen doesn’t respond.</td>
<td>The control panel screen on the MakerBot Replicator Z18 is not a touchscreen. Turn the dial to scroll through the available options on the screen. Press the dial to select.</td>
</tr>
<tr>
<td>Can’t access the Library, Explore and Store sections of MakerBot Desktop.</td>
<td>You may not be logged into your MakerBot account. These features are only accessible when you are logged in. If you are logged into your MakerBot account but are still unable to access the Library, Store and Explore sections, your computer may not be connected to the internet.</td>
</tr>
<tr>
<td>The MakerBot Replicator Z18 is connected to a network, but MakerBot Desktop will only allow you to export, not print.</td>
<td>You may not have established a connection between MakerBot Desktop and your MakerBot Replicator Z18. In MakerBot Desktop, go to Devices &gt; Connect to Makerbot. Choose your MakerBot Replicator Z18 from the list of MakerBot 3D printers on your network and click Connect. When prompted, push the dial on your MakerBot Replicator Z18 to confirm the connection.</td>
</tr>
</tbody>
</table>
## PRINTING PROBLEMS

<table>
<thead>
<tr>
<th>PROBLEM</th>
<th>SOLUTION</th>
</tr>
</thead>
<tbody>
<tr>
<td>The Smart Extruder is installed, but the MakerBot Replicator Z18 does not recognize it.</td>
<td>Remove the Smart Extruder and run the extruder attachment script by going to <strong>Utilities &gt; System Tools &gt; Attach Smart Extruder</strong>.</td>
</tr>
</tbody>
</table>
| A print pauses unexpectedly. | Make sure the front door of the MakerBot Replicator Z18 is closed.  
When the door is opened during a print, the print will automatically pause. When the door is opened while a print is being initiated or during a preheat, the print or preheat will be cancelled.  
To ensure that this does not happen, make sure the front door of the Replicator Z18 is securely closed before beginning a print or preheat. |

If these solutions don’t solve your issue, or if you are having a problem that doesn’t appear here, please contact MakerBot Support by emailing support@makerbot.com. See page 66 for more on how to contact MakerBot Support.
LEVELING THE BUILD PLATE

The build plate on your MakerBot Replicator Z18 is leveled at the MakerBot Factory and locked into place, but over time it might shift slightly. If you observe that your prints are consistently peeling off of the build plate, you may need to level the plate again.

Before leveling your build plate, unload any filament, clear debris from the extruder nozzle and build plate, and allow the Smart Extruder to cool.

1. Begin the leveling process by navigating to **Utilities > Level Build Plate** on the control panel of your MakerBot Replicator Z18.

2. Use the 5 mm hex wrench that came with your MakerBot Replicator Z18 to loosen the four bolts locking the build plate in place.

3. Tighten the two front leveling knobs all the way.
LEVELING THE BUILD PLATE

4. Follow the directions on the control panel. The Makerbot Replicator Z18 will move the Smart Extruder to different positions on the build plate. At each point it will prompt you to adjust one of the leveling knobs and prompt you again when the plate is in the correct position.

⚠️ **Caution:** Only turn the leveling knobs as directed by the instructions on the control panel.

5. When the leveling process is finished, tighten down the four locking bolts to secure the build plate.

6. When the build plate is locked into place, the MakerBot Replicator Z18 will go through a short calibration sequence. Wait until the calibration sequence is complete before initiating any other action on your MakerBot Replicator Z18.
UPDATING FIRMWARE

Firmware is the software that runs on your MakerBot Replicator Z18. Keeping your firmware up to date will help ensure that your MakerBot Replicator Z18 is in the best possible working order. Firmware updates allow MakerBot to add new features to your MakerBot Replicator Z18 and improve old ones.

MakerBot Desktop will let you know if there’s a firmware update available. To upgrade to the new version, just select Upload Firmware from the Devices menu. The software will walk you through the steps to bring your MakerBot Replicator Z18 up to date.

EMPTYING THE FILAMENT WASTE BIN

At the beginning of each print, your Smart extruder will purge some plastic into a small container inside the MakerBot Replicator Z18. This filament waste bin is located in the back right corner of your MakerBot Replicator Z18, and is held in place by a magnet. When the filament waste bin is full, pull it free and empty it of its contents. Then return it to its place inside the MakerBot Replicator Z18.
Specifications

Printing
Print Technology: Fused deposition modeling
Build Volume: 30.5 L X 30.5 W X 45.7 H cm [12.0 L X 12.0 W X 18.0 H in]
Layer Resolution: 100 microns [0.0039 in]
Filament: 1.75 mm [0.069 in] MakerBot PLA Filament
Nozzle Diameter: 0.4 mm [0.015 in]
Print File Type: .makerbot

Software
Software Bundle: MakerBot Desktop Software
3D Model File Types: .stl, .obj, .thing
Supported OS: Windows (7+), Mac OS X (10.7+), Linux (Ubuntu 12.04+, Fedora 19+)

Physical Dimensions
Product Dimensions: 49.3 W x 56.5 D x 86.1 H cm [19.4 W x 22.2 D x 33.9 H in]
Shipping Box: 65.0 x 71.9 x 106.0 cm [25.6 x 28.3 x 41.75 in]
Printer Weight: 41 kg [90 lbs]
Shipping Weight: 52 kg [115 lbs]

Temperature
Ambient Operating Temperature: 15-24°C [60-75.2°F]
Storage Temperature: 0-38°C [32-100°F]

Electrical
Power Requirements: 100-240 VAC; 5.4-2.2 A; 50/60 Hz; 350 W
Connectivity: USB, Ethernet, Wi-Fi

Mechanical
Construction: Powder-coated steel with PC-ABS and aluminum composite material
Build Surface: Injection molded PC-ABS
Stepper Motors: 1.8° step angle with 1/16 microstepping
XY Positioning Precision: 11 microns [0.0004 in]
Z Positioning Precision: 2.5 microns [0.0001 in]

Camera
Camera Resolution: 320 X 240
GLOSSARY

**BACK BUTTON:** The button at the top right corner of the control panel’s LCD screen. The back button will often allow you to return to a previous screen or cancel an action.

**BUILD PLATE:** The plate on which your MakerBot Replicator Z18 prints an object. The build plate on the MakerBot Replicator Z18 has two parts: a removable plastic top plate, and a flat, sturdy aluminum base. Additional plastic top plates are available for purchase at store.makerbot.com.

**BUILD PLATE LATCHES:** Two latches on the front of the build platform that hold the build plate in place. Rotate the latches before removing the build plate.

**BUILD PLATE TAPE:** The heavy tape used as a build surface for your MakerBot Replicator Z18. Sheets of build plate tape for the MakerBot Replicator Z18 are available for purchase at store.makerbot.com.

**BUILD PLATE PLATFORM:** The support for the build plate. The build platform includes knobs for manual leveling.

**CONTROL PANEL:** The LCD screen, dial and buttons at the upper right corner of the MakerBot Replicator Z18. The control panel allows you to start prints, change settings and view status information.

**DIAL:** The rotary/push dial on the control panel. Rotate the dial to scroll through available options and push the dial to select.

**ETHERNET CABLE:** A Cat5e cable used to connect your MakerBot Replicator Z18 to a local area network.

**EXTRUDER ASSEMBLY:** The MakerBot Replicator Smart Extruder installed in the extruder carriage.

**EXTRUDER CARRIAGE:** The part of the extruder assembly that sits on the gantry and moves back and forth. When the Smart Extruder is installed in the extruder carriage, the extruder assembly is complete.

**EXTRUDER NOZZLE:** The opening on the end of the Smart Extruder from which heated MakerBot PLA Filament emerges to be spread onto the build plate.

**FILAMENT DRAWER:** The part of your MakerBot Replicator Z18 that slides out to allow you to load a spool of MakerBot PLA Filament.

**FILAMENT GUIDE TUBE:** The plastic tube that guides the MakerBot PLA Filament from the filament spool to the Smart Extruder.

**FILAMENT WASTE BIN:** A clear plastic container in the back right corner of the MakerBot Replicator Z18. The Smart Extruder purges some plastic into the wipe bucket before prints and after filament changes.
GLOSSARY

**FIRMWARE**: The software that runs on your MakerBot Replicator Z18.

**GANTRY**: The apparatus that allows the extruder assembly to move around.

**HEATED CHAMBER**: The interior chamber of the MakerBot Replicator Z18. The chamber is heated during the printing process.

**INTERNAL STORAGE**: The part of the internal storage on your MakerBot Replicator Z18 that you can use to store print files. The capacity of the internal storage is about 2GB.

**LAYOUT**: An arrangement of 3D models on the build plate. Multiple layouts can be saved as part of any Thing in your Library.

**LEVELING KNOBS**: The three thumbscrews on the underside of the build platform that allow you to adjust the angle of the build plate. Only adjust the leveling knobs as instructed during the assisted leveling process.

**LOCKING BOLTS**: The four bolts that secure the aluminum base of the build plate to the build platform. Only loosen the locking bolts during assisted leveling.

**.MAKERBOT**: The format of print files for your MakerBot Replicator Z18. Print files contain instructions for your MakerBot Desktop 3D Printer.

**MAKERBOT ACCOUNT**: The username and password you will use to sign in to MakerBot Desktop, and log on to Thingiverse and other MakerBot sites.

**MAKERBOT CLOUD LIBRARY**: The part of MakerBot Desktop where you can access your MakerBot Cloud Library and organize your own design files, files downloaded from or collected on Thingiverse™, or files purchased from the MakerBot Digital Store.

**MAKERBOT DESKTOP**: Free software for use with your MakerBot Replicator Z18. MakerBot Desktop will help you discover, manage, share and print 3D models.

**MAKERBOT DIGITAL STORE**: A digital store where you can download premium 3D content.

**MAKERBOT PLA FILAMENT**: Polylactic acid filament. PLA is a corn-based thermoplastic. MakerBot PLA Filament is the source material from which you make objects on the MakerBot Replicator Z18.

**MAKERBOT REPLICATOR Z18**: The MakerBot® Replicator® Z18 3D Printer.

**MENU BUTTON**: The button at the bottom right corner of the control panel’s LCD screen. The menu button will often allow you to open a menu containing additional options.

**.OBJ**: A file format used for 3D models.
GLOSSARY

PROFILE: The settings used to slice your 3D model and create a print file. MakerBot Desktop Software comes with preset profiles for Low, Standard and High resolution prints.

RAFT: A plastic base printed on the build plate and used as a printing surface for your printed object.

SETTINGS DIALOG: The dialog that allows you to change which print settings will be used when you create a print file.

SETUP ASSISTANT: The set of tasks that runs when you turn on the MakerBot Replicator Z18 for the first time. The setup assistant helps you level the build plate, load filament and start a test print. You can access the setup assistant at any time through the Utilities menu.

SLICING: The process of turning a 3D model into a print file containing instructions for your MakerBot 3D printer. The MakerBot Replicator Z18 uses print files with the extension .makerbot.

SMART EXTRUDER: The MakerBot Replicator Smart Extruder draws the filament from the spool, melts it, and pushes it through a nozzle onto the build plate.

SUPPORTS: Automatically generated support structures used to prop up any sections of a print that will not stand alone.

.THING: A file format used by MakerBot Desktop that stores additional information about your 3D model files.

THING: A file or group of files saved to Thingiverse or to your MakerBot Cloud Library.

THINGIVERSE: MakerBot Thingiverse, an online community for sharing 3D design files.

TOP COMPARTMENT: The top chamber of the MakerBot Replicator Z18. It contains the extruder carriage and is separated from the heated chamber by a bellows. The top compartment should always be kept locked when you are using the MakerBot Replicator Z18.

USB CABLE: A cable that allows your computer to communicate with the MakerBot Replicator Z18.

USB DRIVE: A USB flash drive. You can use a USB drive to transfer print files to and from the MakerBot Replicator Z18.

.STL: A widely used file format for 3D models.
HOW TO USE MAKERBOT SUPPORT

At MakerBot, we take pride in offering expert, responsive, friendly customer support to customers around the world. When you call us or open a case on makerbot.com/support, there are a few things you can do ahead of time to help us help you.

HAVE YOUR SERIAL NUMBER READY
The serial number helps us to quickly look up your order and get more complete information on your MakerBot Replicator Z18. The serial number is located on a label on the back of your MakerBot Replicator above the power input port. Your Smart Extruder also has a serial number, which can be found by detaching the Smart Extruder from the extruder carriage.

PROVIDE LIFETIME BUILD HOURS
Knowing how long you’ve been using your MakerBot Replicator Z18 helps us keep track of how our 3D printers are doing. Before you call or open a case, use the control panel on the MakerBot Replicator Z18 to go to Info > Statistics > Lifetime Build Hours and record the number of hours listed there.

BE AS THOROUGH AS POSSIBLE
Please provide as much information as possible about your issue in your initial submission. The more information we have, the more accurately we can identify your issue.
# CONTACT

<table>
<thead>
<tr>
<th>Support</th>
<th><strong>makerbot.com/support</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Our website has extensive documentation and troubleshooting information about your MakerBot Replicator Z18. It's a great resource when you want to try to solve issues quickly on your own.</td>
</tr>
<tr>
<td></td>
<td><strong>makerbot.com/support/submit-a-case</strong></td>
</tr>
<tr>
<td></td>
<td>At MakerBot, we take pride in offering expert, responsive, friendly customer support to customers around the world. If you need help resolving an issue with the MakerBot Replicator Z18, open a case with the MakerBot Support Team at the address above.</td>
</tr>
<tr>
<td>Sales</td>
<td><strong><a href="mailto:sales@makerbot.com">sales@makerbot.com</a></strong></td>
</tr>
<tr>
<td></td>
<td>To learn about other MakerBot products, including MakerBot PLA Filament, please email the address above, or call our Sales Team at 347 334 6800.</td>
</tr>
<tr>
<td>Feedback</td>
<td><strong><a href="mailto:thoughts@makerbot.com">thoughts@makerbot.com</a></strong></td>
</tr>
<tr>
<td></td>
<td>For general questions, or to tell us what's on your mind, send an email to the address above. We love to hear from you, and using this email address helps keep our Sales and Support lines free for customers in need.</td>
</tr>
</tbody>
</table>